
 

 

   
 
 

Richard A. Kunst 
 

Humanities Computing Laboratory, Inc. 
301 W. Main St. Suite 400-I 

Durham, NC 27701 USA 
 

Phone: (919) 667-9556 
Fax: (919) 667-9556 

E-mail: info@humancomp.org 
Web: http://www.humancomp.org 

 
Rev. 2/2002 

WITH  WINCALIS, YOU’VE GOT 
THE WHOLE WORLD IN YOUR HANDS 
 
AN OLYMPICS WINCALIS AUTHOR TUTORIAL, 
HIGHLIGHTING NEW FEATURES IN VER.2.5 



WITH WINCALIS,  
YOU’VE GOT THE WHOLE WORLD IN YOUR HANDS 

CONSTRUCTION GUIDE  2 

This booklet will be your guide for constructing a WinCALIS lesson model on the 
Olympics.  You can work through it as part of a workshop or on your own. In the former 
case, workshop participants will be following along with the model lesson construction in 
synch, and can work on independent lessons as time allows.  English is used as the target 
language of this model lesson to provide a common denominator, but other languages can 
be explored.  Text entry, question and feedback formation, clues, graphics, hotspots, 
tutorials, audio and video, speech recognition, and more will all be addressed in the 
creation of this lesson. 
 
This book will guide you on the “what goes where” in the model lesson; WinCALIS 
Author on-line help gives further details. Available for those interested is an on-line 
Windows tutorial or a printed copy of Windows Basics.  Do not worry if you do not 
complete everything in this guide during a workshop.  This guide also can serve as a 
handy reference for features and methods involved in putting a WinCALIS lesson together.   
 
Key to Graphics: 
 

 

 
Author Program 

 
 
WinCALIS Program 

 

 
Save script file (shortcut key: F4) 

!WINDOWNAME:TASK# E.g.: Interactive (Question):5  
means: (Activate the Interactive [Question] 
Window of Task number 5) 

 

Let the Games Begin!  

Describe, Direct 
 

Launch the WinCALIS Author program.  It opens to the first task of a blank script.  
Though you can proceed in any window, let’s start with introducing the lesson to the 
student and preparing him or her for what is ahead. 

 
!LESSON DESCRIPTION  
Activate (go to) the Lesson Description Window by selecting it from the Window menu 
or clicking on its icon. Now type in this window: 
From Athens to Sydney… 
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Place your caret (blinking cursor showing the insertion point) at the beginning of the 
phrase.  Then choose Format|Fontsize|Large.  (That is: click the menu item ‘Format’, then 
choose the selection ‘Fontsize’, and then ‘Large’.)   
 
The Lesson Description window should now look like this: 

!LESSON DESCRIPTION  
<FS: LARGE>From Athens to Sydney… 
 
Note: The keywords in CALIScript commands are separated by either a colon or a space or a combination of colon and 
space. Varying these “separators” has no effect on functionality. 
 
This window may be minimized now; each lesson only has one Lesson Description. 
 

!POPUP (GROUP DIRECTIONS):1   
Now activate the Popup (Group Directions) Window for Task 1. (From now on, just 
follow the symbol above to go to the appropriate window.)  Press Enter to leave a blank 
line. Type in (line breaks will be retained exactly where you put them): 
 
You will be given some information about a  
great world event.  Read the text given to you,  
and answer the following questions. 
 

It is a good habit to save work often when working on a computer. Let’s save the 
lesson as a file in the workshop tutorial folder before continuing. This will also let 
WinCALIS Author know what folder to find our work in.  Click on File|Script 
Database|Save. In the dialog box that appears, save your file in 
c:\wincal32\scripts\whatsnew\tutorial with your name (e.g: rick.wca; marie.wca) 

Adding a Graphic 

!PRESENTATION (TEXT):1 
Now let’s insert the command to display a “graphic” (i.e., a picture) in the Presentation 
(Text) Window. First insert a <CE> command to center the picture in the window. Either 
simply type the command, or insert it with the menu item Format|Center. 
 
Then click on Tools|Insert Graphic. Scroll down, if necessary, in the list box on the left 
until you see the graphic called “rings.bmp” and select it. Leave the box that says “Height 
of graphic (lines):” set to ‘10,’ which is about right for the size of the Olympic rings 
picture. Click on “OK.”  
 
New: WinCALIS now supports a variety of graphics formats, including not just Windows .BMP files, but also JPEGs,  
.WMF Windows vector graphics files, and Internet .PNG graphics files (but not .GIF files). 
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Your screen will then appear as below: 

!PRESENTATION (TEXT):1 
<CE><GRAPHIC: rings.bmp rings><CUR:+10,1><TAB:0> 
 (The <CUR: +10,1> command will leave 10 blank lines for the picture above the text.) 
 
Now insert the text to be displayed below the picture, so that your window appears as 
below: 

!PRESENTATION (TEXT):1 
<CE><GRAPHIC: rings.bmp rings><CUR: +10,0><TAB:0> 
<CE><SET FS: LARGE><IT>Citius, Altius, Fortius<IT><SET FS MEDIUM> 
 
The commands to set the font size can be inserted either by typing them or by clicking on 
Format|Set|Fontsize|Large (or Medium). Similarly, text can be highlighted and the <IT> 
attribute commands added with Format|Selection|Italic. Notice that you have a way to 
insert any CALIScript command (or option, special response, etc.) without having to 
remember it and type it in.  To browse these, click on Tools|Insert CALIScript|Command.   
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Most of the CALIScript Commands can go right into the script as is; some must be 
customized.  Text and screen formatting commands can be found under the Format menu. 
For example, Format|Center, which will place a <CE> command right in the window.   
 

Posing Questions 

!INTERACTIVE (QUESTION):1 
 
These rings and this motto are the symbols of: 
Here, a question is given.  Now some responses must be anticipated.   
Click on Task|Open Response (Short Answer), or Ctrl+O.   
 

 
 
Type in the Anticipated Response and Feedback for Response 1.  Notice that the 
Response Type appears with the Correct / Continue radio button chosen.  After this 
response is filled, click the Next Response button, and continue entering the following: 
 
Response 
Type: 

Current 
Response: 

Anticipated Response: Feedback: 

Correct / 
Continue 

1 the Olympics Yes, these are the symbols of the 
Olympic Games. 

Correct / 
Continue 

2 &[Oo]lympic& Yes, these are the symbols of the 
Olympic Games. 

Incorrect/ 3 &{games|sports|competition}& Be more specific… 
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Remain here 
 
Click on the Done button.   
 

Save! 
  
Included in the above anticipated responses were the wild card characters ‘&’ and ‘{}’ 
and ‘[]’. After the “model” Correct/Continue response (for use in Spellmarking and in 
case the student should Give Up), anticipated answers with wild card characters allow for 
a broader range of responses.  Anticipated responses should be ordered from specific to 
general, for optimum WinCALIS answer analysis.  Notes for reference: 
 
The Wild Card Characters: 
Wild Cards Which Match Single Characters 
 
^ 
The caret wild card will match any single character.  For example: the anticipated response, "^ate" will match "date," 
"fate," "late," and nonsensical words like "xate" and "aate."  It will not match "grate" or "berate," because the section of 
the word preceding the "ate" part has more than one letter. 
 
[ ] 
The bracket wild card will match any one of the letters found within the brackets.  No comma or notation is needed in 
between the list of the characters, because the bracket notation tells WinCALIS to match only one character.  For 
example: the anticipated response, "[blr]ump" will match "bump," "lump," and "rump," but not "jump" or "clump," etc. 
 
[ - ] 
In order to anticipate a long series of sequential characters, you may use the hyphen "-" to separate the bounds of the 
sequence within the brackets.  For example "[A-Z]" will match any capital letter between "A" and "Z" (but not any 
lower case letters).  "[1-9]" will match the numerals 1 through 9.  Specifying the first and last letters of the Cyrillic 
alphabet will match any Cyrillic character. And specifying the first and last characters in the Unicode  
"Han" (Chinese-Japanese-Korean) character pages will match any Han character. 
 
Wild Cards Which Match Single Words 
* 
The asterisk character will match any sequence of characters in a word and therefore is the most versatile of the one 
word bounded wild cards.  For example: "*es" will match "noses," "proxies," "heroines," etc.  It may be used at the 
beginning, middle or end of the response to match any character or group of characters except the space character. 
 
Wild Cards Which Match Anything 
 
This set of wild cards will function over a string of one or more words. 
 
& 
The ampersand wild card will match anything, including the space character ( ).  For example: "The chickens &" will 
match "The chickens are escaping," "The chickens have demolished New York," etc. 
 
| The Vertical Bar 
 
 
The vertical bar wild card character | (usually above the backslash \ on most keyboards) separates explicit alternatives, 
any of which will match.  The bar functions as an "or" operator.  Thus "never|hardly ever" will match "never" and will 
also match "hardly ever" (but not "never ever").  
 
{ | } 
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{response1|response2|response3|etc} 
 
In cases where the vertical bar used alone would be ambiguous, braces are used in conjunction with the vertical bar to 
show how a series of anticipated responses are grouped.  The "|" character functions as an "or" operator.  For example: 
"The Baltimore Orioles are the {best|most feared|world champion} team" will match "The Baltimore Orioles are the 
best team", "The Baltimore Orioles are the most feared team", and "The Baltimore Orioles are the world champion 
team".  
 
Note: Braces may be used within braces, a technique called nesting, to provide even greater flexibility in anticipating 
responses. 
 

!INTERACTIVE (QUESTION):2 (Use the menu item Task|Next or Task|Previous 
(shortcuts Ctrl+N or Ctrl+P or '+' and '-' keys on number keypad) to move between tasks). 
 
 
The Olympic motto, in Latin “Citius, Altius, Fortius,” translates to English as: 
 
Choose Task|Multiple Choice, and enter the following: 
 
Response 
Type: 

Current 
Response: 

Anticipated 
Response: 

Feedback: 

Correct / 
Continue 

1 faster, higher, braver Yes, this is the original translation. 
The motto was coined by Father Didon, 
a French educator, in 1895.  The modern 
translation is “swifter, higher, stronger.” 

Incorrect/ 
Remain here 

2 Europe, America, and 
Africa 

Though the Olympics are an international event, 
this is not what the motto translates to. 

Incorrect/ 
Remain here 

3 control, accuracy, 
strength 

The element "strength" is represented, but there 
is a better answer choice. 

Incorrect/ 
Remain here 

4 Charles, Atlas, and 
Frederick 

These names do not appear in the Olympic 
motto. 

 
Click on the Done button.   
 

Save! 
 

Since we have two questions, some text, and a graphic completed already, let’s try 
running the script.  Normally, you can run a script, or just one or more tasks, most easily 
by going to Script|Run Script… (shortcut Ctrl+R) and choosing what you want to run. 
However, so that you are aware that WinCALIS is a separate application and also to 
experience the WinCALIS opening screen, this time go to the Windows 9x/NT/2000 Start 
Menu and launch WinCALIS (or use Alt+Tab to switch over to WinCALIS if you already 
have it running).  Navigate to the c:\wincal32\scripts\whatsnew\tutorial folder and locate 
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“yourname” script.  (You can adjust what files WinCALIS displays, if necessary, under the 
Options menu.) Double-click on the lesson name, or click the Run button while the lesson 
name is highlighted. Your first task will look like the screen shot below. Be sure to try 
first one or more incorrect responses first, then a correct response, so you can check your 
feedbacks. 
 

 
Switch applications (using Alt+Tab or the Task Bar) back to WinCALIS Author: 
 

 
 
Task 3 will show the student a chart in the Presentation (Text) Window on the left side of 
the screen and in the Interactive (Question) Window on the right side, you will ask the 
student to click with the mouse on the correct answer in the chart on the left.  Moving the 
windows around will be accomplished by inserting window SIZE commands. 
!INTERACTIVE (QUESTION):3 
<SIZE: 0,50,100,100> 
This chart shows where the   
Olympic Games were held. 
 
Click on the site where the Games 
were held in the year 1896. 
 
The <SIZE> command can be typed directly or inserted at the caret (insertion point) by 
clicking on Format|Size Window…, and inserting the numeric values. 
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Click on the OK button.   
 
Notice the Window SIZE commands at the top of the Interactive (Question) and Presentation (Text) Window of this 
Task.  The syntax for this command is  <SIZE [W]:top,left,bottom,right>.  For efficiency, you may use the Size 
Window… dialog box found under the Format menu item.  It reminds you what the four coordinates refer to, and then 
places the full command into your script. 
 
Window Name   [W]: 
Interactive (Question) Window  Q 
Presentation (Text) Window   T 
Tutorial Windows    F[1-10] 
Diagnostic Feedback Window D 
 
Window Dimensions (top, left, bottom, right): 
top any number between 0 and 100 
left any number between 0 and 100 
bottom any number between 0 and 100 
right any number between 0 and 100 
 
 
Example: <SIZE Q 5,10,75,45>.  

 
 
 
 
 
 
 
 
 

5 

10 

75 

45 

Screen parameters 

Window size 
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!PRESENTATION (TEXT):3 
WinCALIS retains the contents of the Presentation (Text) Window (which can include 
graphics) until any changes are made.  Starting with this task, we will use different 
contents in the Presentation (Text) Window. Some text listing the sites of the Olympics 
Games will be used. The pre-typed plain text is in a file called “gamesite.txt,” and can be 
imported into the Presentation (Text) Window by clicking in that window to make it the 
active window, then clicking on File|Document file|Open. We could use the same 
procedure with material obtained from the World Wide Web—first saving it to a file, 
then importing it into WinCALIS. Or we could copy and paste the content directly from a 
Web browser—even multilingual content, since the browsers understand Unicode just 
like WinCALIS. 
 
See below for how the Presentation (Text) Window will look. The <IT> italics 
commands can be typed directly or inserted by highlighting the text to be italicized, then 
clicking on Format|Selection|Italic. Insert the SIZE command as you did above for the 
Interactive (Question) Window. If you wish, you can make your Author windows appear 
side-by-side, as they will in WinCALIS, by selecting Window|Tile Vertically. 
 
Sites of Olympic Games 
1896 Athens, Greece 
1900 Paris, France 
1904 St. Louis, U.S. 
1906 Athens, Greece 
1908 London, England 
1912 Stockholm, Sweden 
1920 Antwerp, Belgium 
1924 Paris, France 
1928 Amsterdam, Netherlands 
1932 Los Angeles, U.S. 
1936 Berlin, Germany 
1948 London, England 
1952 Helsinki, Finland 
1956 Melbourne, Australia 
1960 Rome, Italy 
1964 Tokyo, Japan 
1968 Mexico City, Mexico 
1972 Munich, W. Germany 
1976 Montreal, Canada 
1980 Moscow, USSR 
1984 Los Angeles, U.S. 
1988 Seoul, S. Korea 
1992 Barcelona, Spain 
1996 Atlanta, U.S. 
2000 Sydney, Australia 
 
 
 

Save! 
 

(how gamesite.txt should look after formatting and mark insertion:) 
 
<IT>Sites of Olympic Games<IT><SIZE: 0,0,100,50> 
1896 <M:x1>Athens, Greece<M:y1> 
1900 <M:x3>Paris, France<M:y3> 
1904 St. Louis, U.S. 
1906 <M:x2>Athens, Greece<M:y2> 
1908 London, England 
1912 Stockholm, Sweden 
1920 Antwerp, Belgium 
1924 Paris, France 
1928 Amsterdam, Netherlands 
1932 Los Angeles, U.S. 
1936 Berlin, Germany 
1948 London, England 
1952 Helsinki, Finland 
1956 Melbourne, Australia 
1960 Rome, Italy 
1964 Tokyo, Japan 
1968 Mexico City, Mexico 
1972 Munich, W. Germany 
1976 Montreal, Canada 
1980 Moscow, USSR 
1984 Los Angeles, U.S. 
1988 Seoul, S. Korea 
1992 Barcelona, Spain 
1996 Atlanta, U.S. 
2000 Sydney, Australia 
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Now we will make some parts of this text “hot”.  Making hot text is a two-part process: 
first you must insert “marks” to indicate where the hot text starts and ends, and secondly 
you must associate some action or response with clicking on that text. Our marked areas 
will be referenced in the anticipated responses.  First: Highlight the section of text that 
you wish to mark (Athens, Greece). Then click on Tools|Mark Hot Text…. Select the 
“Correct/Continue” radio button. Then in the box labeled “Hot text click action,” type the 
feedback “Yes, they were held in Athens, Greece.” Click on OK. 
 

 
 
WinCALIS automates this process of marking hot text by inserting both the responses and 
the computer’s resulting action for us in the Answer/Feedback dialog box. Verify this by 
returning to Task 3 (Ctrl+P) (since you were automatically taken to a new task when you 
clicked on “OK” in script-creation mode), making your Interactive (Question) window 
active, then clicking on Task|Open Response (Short Answer), or Ctrl+O. What you just 
entered in the Mark Hot Text dialog box should now appear here. 
 
Now review this process by repeating it for two more responses, the second occurrence of 
Athens, Greece, and the first occurrence of Paris, France: 
 
Note: The mark counter will continue to increment during an editing session. In a subsequent new session, it will reset 
to 0.  You can set the mark counter to any number you wish at any time with Format|Insert Marks|Reset Mark 
Counter….  CALIScript mark labels can be any arbitrary combination of numbers and letters. They should be unique. 
Other than this, keeping numbers in sequence is for your own editing convenience. 
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!INTERACTIVE (QUESTION):3 
Response 
Type: 

Current 
Response: 

Highlighted Text 
(Anticipated Response): 

Feedback: 

Correct / 
Continue 

1 Athens, Greece 
(<MOUSE: x1 y1>) 

Yes, they were held in Athens, Greece. 

Correct / 
Continue 

2 Athens, Greece 
(<MOUSE: x2 y2>) 

Yes, the Olympics were held here in 1896 
and then again in 1906. 

Incorrect/ 
Remain here 

3 Paris, France 
(<MOUSE: x3 y3>) 

No, they weren't in Paris in 1896.  
Check the chart again. 

 
 
Alternative procedure for marking text: Highlight the section of text that you wish to mark (Athens, 
Greece), then click Format|Selection|Insert Marks|Plain Text. The labels for each subsequent marked pair 
will be increased by 1.  Then make the Interactive (Question) Window active and choose Task|Open 
Response (Short Answer), or Ctrl+O. Insert the <MOUSE x1 y1> Special Responses either by typing them 
or by inserting them from the drop-down list box “Pull down for Special Response or wild card.” 
 
We will also enable two options for this task only: one that keeps the student’s mouse 
pointer as an arrow (instead of turning into the hand image as it does by default on hot 
areas), and the other that disables keyboard input. Make the Task 3 Interactive (Question) 
Window active and choose Task|Open Response (Short Answer), or Ctrl+O. Click on the 
Options button, then the More Options button. Enable “No mouse hand pointer” and 
“Disable keyboard.”  Click Done three times to save the contents of both Options boxes 
and the dialog box. 

 
!INTERACTIVE (QUESTION):4 
<SIZE: 0, 50,100,100> 
 
Name at least two United States cities that 
have hosted the Olympic Games. 
<FS FINE>( type answers one at a time, followed by Enter) 
 
Then choose Task|Open Response (Short Answer), and enter: 
 
Response Type: Current 

Response: 
Anticipated Response: Feedback: 

Correct / 
Continue 

1 St. Louis Yes, St. Louis in 1904. 

Correct / 
Continue 

2 Los Angeles Yes, Los Angeles hosted in 1932 
and again in 1984. 

Correct / 
Continue 

3 Atlanta Yes, Atlanta in 1996. 
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Since in this question the student is asked to name 2 of the U.S. sites where the Olympics 
were held, we will tell WinCALIS to consider this task completed when 2 of the 
Correct/Continue responses have been entered.  This is done by choosing Options, More 
Options, and “All n Answers”, and then typing 2 in the “Enter Number of Answers n:” 
box.  

Push Me! 
In this task, let’s design a button, with an associated clue.  While still in the Interactive 
(Question) Window of Task 4, place your cursor two lines below the rest of the text. 
 
Then click on Tools|Insert Button…. In the dialog box which appears, enter the 
following: 
 
Response Type: Neutral, No Re-execute (the default) 
Button Location, Line 
number on screen: 

6  
(or leave set to 0, if you place the button manually; with other settings left at 
0, button will be centered by default in Interactive Window, like all text) 

Button Type: Windows Text Button 
NOTE: if you would like to have non-Roman Unicode text on the button (like 
Arabic or Korean), you would create a Unicode (OWNERDRAW) button 
instead of a NORMAL Windows button. 

Width in pixels: 50 
Height in pixels: 25 
Cursor position after 
button: 

8 
A cursor placement command is given after the button, so the prompt appears 
in a suitable place for the student, not right on top of the button. 

Text on Button: Clue 
Button Action (text): Replace “Write text or enter commands here” with the following: 

Look for: 
 1904   St. Louis 
1932 Los Angeles 
1984 Los Angeles 
1996   Atlanta 

 
Press “Done.”  
 
The Interactive (Question) Window should now look like this: 
<SIZE: 0, 50,100,100> 
Name at least two United States cities that 
have hosted the Olympic Games. 
<FS FINE>(type answers one at a time, followed by Enter) 
 
<BUTTON: BtnQ1, CREATE, "Clue", NORMAL, 50, 25><CUR:8,> 
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Alternative procedure for creating a button:  With your cursor where you want the button, type the 
following (or use the Tools menu item Insert CALIScript|Command, by selecting <BUTTON name 
CREATE,"Label" NORMAL w,h> and then editing the string so it reads as shown below: 
<BUTTON BtnQ1 CREATE,"Clue" NORMAL 50,25><CUR +2> 
 
Now go back into the Task 4 Open Response dialog box (by clicking on Task|Open 
Response (Short Answer), and verify that your BUTTON response has been added there 
as Response 4. Or if you follow the manual alternative, you will need to type in the 
following anticipated response to handle the button click: 
 
Response Type: Current 

Response: 
Anticipated Response: Feedback: 

Neutral, No-
Re-execute 

4 <BUTTON: BtnQ1 
CLICKED> 

Look for: 
 
1904 St. Louis 
1932 Los Angeles 
1984 Los Angeles 
1996 Atlanta 

 

Save! 
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HOT STUFF! 
 
For the remainder of this Olympics tutorial the Interactive Question Window will fill the 
WinCALIS screen, so maximize the Interactive Question Window in Author in order to 
work most effectively. 
 
Task 5 will display a graphic of a map of the Southeastern U.S. (georgia.bmp), and then 
ask the student to click on Atlanta. The active areas of the map are called “hotspots.” 
 

!INTERACTIVE (QUESTION):5 
<SIZE Q:0,0,100,100><SIZE T: 0,0,0,0> 
Click on the site of the 1996 Olympics: 
 
 
The SIZE commands minimize the Presentation (Text) Window and maximize the 
Interactive (Question) Window. First insert the graphic a line or two below the 
instructions to the student, as you did in Task 1 above. With the Interactive Question 
Window active and the blinking caret two lines below the text, click on Tools|Insert 
Graphic…  to open the Insert Graphic dialog box. 
 
First select the graphic “georgia.bmp.” Then click on the button “Create Hotspot....” This 
opens the “Create Hotspot on Graphic” dialog box, which can also be opened directly by 
clicking on Tools|Create Hotspot on Graphic.… The entire graphic is “hot” by default. 
But we want just the part around Atlanta. So select the radio button “Part of Graphic,” 
then press the button “Define Custom Size.” Enter the percentages “40, 45, 50, 50” 
(greater Atlanta); then click on OK.  
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Now back in the “Create Hotspot on Graphic…” dialog box, leave the Response Type set 
at the default “Correct/Continue”; and for the “Hotspot click action,” replace “Write text 
or insert commands here.” with  
 

“Yes! The Olympics were in 
Atlanta, Georgia for the 1996  
Games.” 

 
Note that “georgia” has automatically been supplied here as the “Hotspot name” (more 
precisely the name of the graphic containing the hotspot). Any name will do, but Author 
simply uses the name of the graphic itself, sans extender).  When you make subsequent 
hotspots directly using the “Tools|Create Hotspot on Graphic…” dialog, you will need to 
supply that name yourself, since Author will not be able to supply it automatically. 
 
Click on OK twice to close both the Hotspot and the Graphic dialogs. Since you are 
automatically taken to the next task, return to Task 5, where there is more to do.  
 
The Interactive (Question) Window should now look like this. 
 
<SIZE Q:0,0,100,100><SIZE T: 0,0,0,0> 
Click on the site of the 1996 Olympics: 
 
<GRAPHIC: georgia.bmp georgia><CUR:+10,1><TAB:0> 
 
This creates a link to a graphic file on disk of a map of the Southeastern U.S. 
(georgia.bmp), and then it gives it a name (here, “georgia”), by which it can be referred to 
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when defining hotspots.  As with the hot text in Task 3, the Author program has 
automatically created the Special Response for the mouse click on the hotspot. Verify this 
by choosing Task|Open Response (Short Answer). It should look like this: 
 

 
 
Now review the process of creating hotspots by repeating it for three more incorrect 
hotspot responses. Since you have already specified the graphic on which the hotspots are 
defined, start with “Tools|Create Hotspot on Graphic….” Select the Incorrect/Remain 
Here Response Type; replace “default” as the Hotspot name with “georgia”; then Part of 
Graphic (except for Response #4, which is the “everywhere else” response, including 
100% of the graphic); then specify the percentages; then type in the text for the Hotspot 
click action; etc.   
 
 
Response 
Type: 

Current 
Response: 

Anticipated Response: Hotspot click action 
(Feedback): 

Correct / 
Continue 

1 <HOTSPOT georgia 40, 45, 50, 50> Yes!  The Olympics were in 
Atlanta, Georgia for the 1996 
Games. 

Incorrect/ 
Remain here 

2 <HOTSPOT georgia 25, 60, 40, 70> No, they were not in North 
Carolina. Try further south. 

Incorrect/ 
Remain here 

3 <HOTSPOT georgia 20, 20, 80, 45> Not quite -- go toward the 
east… 

Incorrect/ 
Remain here 

4 <HOTSPOT georgia 0,0,100,100> Hint: It was in the state of 
Georgia. 

 



WITH WINCALIS,  
YOU’VE GOT THE WHOLE WORLD IN YOUR HANDS 

CONSTRUCTION GUIDE  18 

When you have done the three remaining responses, verify that your Special Responses 
were properly added for this task by choosing Task|Open Response (Short Answer). 
While you have the Answer/Feedback dialog box open, go into Options|More Options 
and check the box next to Disable Keyboard, in order to keep the blinking cursor from 
appearing. 
 

Save! 
 
 
Try running the lesson and trying the new tasks. 
 
Percentage coordinates for hotspots are determined much like the method for window 
resizing, except that you are working with creating the percentages for the hotspot within 
the dimensions of the graphic. Marking coordinates for hotspots usually takes some trial 
and error.  As you become more familiar with sizing and percentages, then it will go more 
smoothly. There are a few mathematical methods that you may use, e.g., in Windows 
Paint or another graphics program, to be more precise in your coordinates.  
 
Alternative procedure for creating a hotspot on a graphic: Choose Task|Open Response (Short Answer) 
and insert the <HOTSPOT georgia w,x,y,z> Special Responses either by typing them or by inserting them 
from the drop-down list “Pull down for Special Response or wild card.” 

Sounds Good! 
 
In the following question models, we will record the student’s voice, include some audio 
clips, and a bit of video.  Remember that you can place the clips virtually anywhere that 
you want; we will be placing some in the Interactive (Question) Window, some in the 
feedback window.  Before we put in the clips, we need to prepare them from the sources.  
From Tools|Multimedia Editor, or from the Windows Start Menu or Program Manager, 
launch the WinCALIS Multimedia Editor component.  
 
*Advanced Option* 
As time and equipment allow, you may be able to record your own *.wav files for 
embedding in the lesson (if not, no problem: you can use a prerecorded one). 
To record a wave audio file:  
In the WinCALIS Multimedia Editor, the Windows Sound Recorder, GoldWave (in the 
3rdparty folder on the WinCALIS CD), or another program that will allow recording from 
a microphone), click the record button (a microphone is pictured).  Read the following 
text clearly and slowly: 
 
The most important thing in the Olympic Games is not to win but to take part, just as the 
most important thing in life is not the triumph but the struggle.  The essential thing is not 
to have conquered but to have fought well. 
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When you have finished reading, click the stop button (a square).  Now save the file as 
creed***.wav (with your initials as the last three characters) in the same folder where you 
have been saving your script. If you click on File|Save in the WinCALIS Multimedia 
Editor, you will see a warning, “Save changes to the wave file?”. This is because the 
File|Save menu item in Multimedia Editor is primarily intended to save *.mmd clip files. 
Answer “Yes,” save your recording, then cancel the following dialog box for saving the 
clip file, since you haven’t defined any clips yet. 
 
After opening or recording the .wav file in the Multimedia Editor, it is ready for 
‘clipping’.  Open the file by first launching the Multimedia Editor, then by choosing 
Device|Sound.  Select the file called creed***.wav. (Some may have saved the file with 
their initials as the last three characters, some may be using creedsls.wav).  To make 
clips: 
 
• Place the slider at approximately the point you want the clip to begin, then click the 

Mark In button to indicate the beginning  
• Move the slider or click the play arrow to advance, then click the Mark Out button to 

indicate the end point.  Adjustments to the start and end points can be made by 
resetting the slider and clicking Mark In or Out again. 

• Name the clip by clicking on the button pictured with a bit of tape reel.   
 
Make a clip of the entire .wav file and call this ‘all’.  Try making some clips of other 
lengths and at different Mark In and Mark Out points.  When you save the .mmd file, be 
sure you not only put it in the same folder, but also give it the same name as your lesson 
(yourname.mmd).  
 
Now we will invite the student to record his or her voice, and then play it back.  This will 
be done in a few stages. In particular, we will put the actual recording of the student’s 
voice all by itself in a separate Task 7, in order to manage it most easily. We will lead up 
to the recording in Task 6, and play it back in Task 8. 
!POPUP (GROUP DIRECTIONS):6 
 
 
You will be presented with the text of the Olympic creed and be given 
the opportunity to record yourself reading it.  Then you can compare your 
reading to that of another speaker. 
 
<GRAPHIC: medals.bmp medals><CUR +10,1><TAB: 0> 
 
To avoid typing the text of the creed, you may import the document file “creed.txt” from 
your working tutorial folder (review Task 3 for how to do this). 
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!INTERACTIVE (QUESTION):6 
 
<IT>Please read aloud the Olympic creed: 
 
<SET FC BLUE> 
The most important thing in the Olympic Games is not to win but to take part,  
just as the most important thing in life is not the triumph but the struggle.  
The essential thing is not to have conquered but to have fought well. 
<SET FC BLACK> 
 
 
 
 
<CUR:14><CE>Press the Enter key twice in order to record your voice. 
<CE>Recording will end automatically after 15 seconds. 
 
(remember, you can find these commands in the Format menu or the Tools|Insert 
CALIScript|Command… menu) 
 
Under Task|Open Response (Short Answer): 
Response Type: Current 

Response: 
Anticipated Response: Feedback: 

Correct / 
Continue 

1 <ENTER>  

Click on Options, and change the following: uncheck Score, uncheck Praise, uncheck 
Center Prompt [More Options] check Allow Repeat (if it is not checked). 
 

!INTERACTIVE (QUESTION):7 
<AUDIO: RECORD TEMP$$.WAV 15000> 
<CUR 14><CE><DKGREEN>Now press any key to hear your recording  
<CE><DKGREEN>and compare it to another speaker's version. 
 
The above syntax tells WinCALIS to record audio to a file called “temp$$.wav” for 15 
seconds (15000 milliseconds). To insert the command automatically to record the 
student’s voice, click on Tools|Insert Audio Clip…. Select “Record student” and specify 
the file name “temp$$.wav” and a recording time limit of 15 seconds. Click on OK. 
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In the Open Response (Short Answer) dialog box: 
Response Type: Current 

Response: 
Anticipated Response: Feedback: 

Correct / 
Continue 

1 <KEY: ANY>  

Options: uncheck Score, uncheck Praise (feedback), [More Options] check Allow Repeat 
(if it is not checked), uncheck Blank Interact. Q Window. 
 

!INTERACTIVE (QUESTION):8 
 
<IT>Your recording: 
<SET FCOLOR: BLUE> 
The most important thing in the Olympic Games is not to win but to take part,  
just as the most important thing in life is not the triumph but the struggle.  
The essential thing is not to have conquered but to have fought well. 
<SET FCOLOR: BLACK> 
<AUDIO: PLAY TEMP$$.WAV><DELAY: 16> 
 
<IT>Now listen to the creed as read by another speaker. <DELAY: .5> 
<AUDIO: all> 
<DELAY: 14> 
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<SET FS: SMALL> Choose one: 
Record and listen again 
Listen again only 
Continue to the next task 
<SET FS MEDIUM> 
 
There are many things happening in this task!  First, some text is shown, and the student’s 
temporary audio file is played.  A delay of 16 seconds keeps the rest of the text from 
appearing until later.  Then your previously prepared audio clip is played, and yet another 
delay keeps the rest of the text at bay.  Then we offer the student a few choices about 
what to do next. 
 
To insert the command to play back the student’s voice, you can either type it directly or 
click on Tools|Insert Audio Clip…. Select “Play wave file directly” and specify the same 
file name you used to record, “temp$$.wav.” Click on OK. Similarly, to insert the 
command to play the clip ‘all’, click on Tools|Insert Audio Clip…, and select the clip 
‘all’ and press OK. 
 
The three lines in reduced text at the bottom of the screen give the student the choice of 
looping back through Tasks 6, 7, and 8 and starting the recording process again; or just  
listening by repeating Task 8; or continuing on to the next task. Here is how to create the 
choices:  
 
Then one at a time, mark each of the choices as hot text and tell WinCALIS how to 
respond if the student clicks on it. As in Task 3 above, first highlight the section of text 
that you wish to mark (e.g., Record and Listen again). Then click on Tools|Mark Hot 
Text. Enter the settings you need, Then click on OK. Repeat for all three choices. 
 
Tools|Mark Hot Text Responses: 
Response 
Type: 

Current 
Response: 

Highlighted Text 
(Anticipated Response): 

Color and 
Style: 

Hot text click 
action: 

Correct / 
Continue 

1 Record and listen again 
(<MOUSE: x4 y4>) 

Uncheck “No 
change in 
formatting” 

<INSERT: 6,7,8> 

Incorrect/ 
Remain 
Here  

2 Listen again only 
(<MOUSE: x5 y5>) 

Uncheck “No 
change in 
formatting” 

Delete “Write text 
or insert 
commands here.” 

Correct / 
Continue 

3 Continue to the next 
task 
(<MOUSE: x6 y6>) 

Uncheck “No 
change in 
formatting” 

Delete “Write text 
or insert 
commands here.” 

 
Go to Task|Open Response. First verify that the responses you created are there. Now 
let’s add a small embellishment: we will handle the student’s pressing a single key on the 
keyboard as an alternative to a mouse click—‘r’ for “Record and listen again,” ‘l’ (el) for 
“Listen again only,” and ‘c’ for “Continue to the next task.” We will do this like Author 
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did automatically for the Multiple Choice questions in Task 2 above, using the <KEY 
‘x’> Special Response. Go to Anticipated Response 1 and put your insertion point 
(blinking caret) at the end of the <MOUSE: x4 y4> response. Pull down the list of special 
responses and select the <OR> response. Then select the <KEY ‘x’> response. Change 
the ‘x’ to an ‘r’. Now copy the string “<OR><KEY ‘r’>” to the clipboard (Ctrl+C), then 
paste it into Anticipated Responses 2 and 3 (Ctrl+V), changing the ‘r’ into an ‘l’ or a ‘c’ 
respectively. 
 

 
 
Finally, click on Options and uncheck Score, uncheck Praise (feedback), [More Options] 
be sure Allow Repeat is checked, check Blank Question Window. 
 
Click on Done. 
 
We will suggest the “Press a key” option visually to the student by underlining just the 
first capitalized letter in each choice. Do this by cutting the <UL> command, which 
toggles underlining off, from near the end of each line and pasting it just after the capital 
letters‘R’, ‘L’, or ‘C’. 
 
Here is how the choices at the bottom of the Task 8 Interactive (Question) Window will 
look when we are done: 
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!INTERACTIVE (QUESTION):8 
. 
. 
. 
<SET FS: SMALL> Choose one: 
<BLUE><UL><M:x4>R<UL>ecord and listen again<M:y4><BLUE> 
<BLUE><UL><M:x5>L<UL>isten again only<M:y5><BLUE> 
<BLUE><UL><M:x6>C<UL>ontinue to the next task<M:y6><BLUE> 
<SET FS MEDIUM> 
 
Be sure that you have finished typing in or inserting any other needed formatting and 
<DELAY> commands in the Task 8 Interactive (Question) Window. 
 

Save! 
 
Now you can see why the previous tasks were made to “Allow Repeat”: so that they 
could be presented again should the student decide to come back to them. 
 
The “marks” which keep track of locations on the screen, like ‘x4’, ‘y4’, ‘x5’, ‘y5’, etc., 
can be any alphanumeric strings, just as long as they are unique within any task. If you 
prefer to reset your numeric index back to ‘x1’, ‘y1’, etc., you may do so with 
Format|Selection: Insert Marks|Reset Mark Counter. 
 
Alternative procedure for handling Special Responses: We could also mark up the text manually using 
the Format|Selection: Insert Marks menu options, then put the anticipated responses in the Author Pass 
Through window. For some tasks, this is a more efficient way of including additional anticipated responses.  
In particular, for selections that you may want to repeat in multiple tasks, it may be easier to enter them this 
way by copying to the clipboard once and repeated pasting (like a button that occurs throughout many 
tasks).  

!PASS THROUGH:8 
+<MOUSE x4 y4><OR><KEY: 'r'>;<INSERT: 6,7,8> 
-<MOUSE x5 y5><OR><KEY: 'l'> 
+<MOUSE x6 y6><OR><KEY: 'c'> 
The Pass Through window allows you to write directly to the *.CAL script file.  Refer to the WinCALIS 
Author User’s Guide, in the Quick Reference section, to learn more about CALIScript symbols and syntax.  
 

Extra! Extra! Adding a Tutorial 
Let’s add a tutorial, providing the student with some extra information. We will enter and 
then save the text for the tutorial in the Scratchpad as a separate file. To make the Tutorial 
available to the student at any time during the exercise, go back to Task 1. Maximize the 
Scratchpad window and type (or copy and paste from the Task 8 Interactive [Question] 
Window): 
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The Olympic Creed 
 
The most important thing in the Olympic Games is not to win but to take part, just as the 
most important thing in life is not the triumph but the struggle.  The essential thing is not 
to have conquered but to have fought well. 
 
Make any other formatting and style changes you would like (window sizing, colors, or 
font sizing).  Save this file as “creed***.txt” (with the last three characters being your 
initials) in the same folder as the lesson. Now let’s make that file available to the student 
starting with this Task 1.  With the Interactive (Question) Window active, choose 
Task|Tutorial Files...  Fill in the edit boxes as follows in the picture below, entering under 
Shift+F2 “creed***.txt” as the Text file name and “The Olympic Creed (transcription)” 
as the Window Title. 
 

 
 

Click OK and then Save! 
 
Try running the lesson and trying out your work. Note that there is now a tutorial 
available to the student anytime under the Tutorial Menu. 
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Looks Good! 
Switch back over to the Multimedia Editor, where we will add a video file.  If you are 
still running Multimedia Editor and yourname.mmd file is still open, then work in there.   
 
IF YOU ALREADY MADE AN *.MMD FILE, BE SURE TO OPEN THAT ONE if you 
want to add more ‘devices’ (pieces of multimedia) to it.  Do NOT start another fresh 
*.mmd file because then it won’t connect with your script.   
 
To associate a video file, click on Device|Video_for_Windows. Look in the current 
subfolder for a file called T057673a.avi.  It is borrowed, with our appreciation, from the 
Microsoft Office Bookshelf CD-ROM.  Open this, and you will see the first frame in 
front of you.   
 
Create a clip that begins at frame 68, and ends at frame 110. Name this clip ‘mens’.  Then 
we will create a clip that consists of the entire file, by placing the slider at the beginning 
and clicking Mark In, and then pulling the slider to the end and clicking Mark Out.  Name 
this one ‘full’.  Save the yourname.mmd file (which now holds the .wav file and 
corresponding clips, and the video file and the corresponding clips). 
 

!INTERACTIVE (QUESTION):9 
<VIDEO PLAY: mens> 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
What Olympic sport is the topic of this video clip? 
<FS: SMALL>For more on this event, type "more".<FS: SMALL> 
(“Yes, those are 15 blank lines in there!”) 
 
To insert the command automatically to play the video clip named ‘mens’, click on 
Tools|Insert Video Clip….  Select the desired clip from the list of already defined video 
clips. Either accept the defaults for location etc., or specify the desired settings. For 
example, select “Play and freeze.” Then click on OK.  
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This will insert a whole string of commands in the active window: 
<VIDEO:SIZE QUARTER><VIDEO:LOC CE><VIDEO:PLAY mens> 
<VIDEO:AUDIO STEREO><VIDEO:LINE1>. 
 
Most of these are defaults and would only be needed if you had selected something 
different previously. The essential commands are <VIDEO:PLAY mens> and 
<VIDEO:LOC CE>. 
 
Choose Task|Open Response (Short Answer). 
Response 
Type: 

Current 
Response: 

Anticipated Response: Feedback: 

Correct / 
Continue 

1 gymnastics Yes. Gymnastics includes floor exercises,  
the horse, the vault, parallel and uneven bars,  
horizontal bar, balance beam, and rings. 

Neutral No 
Re-execute 

2 more <VIDEO PLAY: full>Here are the women's and 
the men's gymnastics events in the Olympics. 
<Q><CUR:prompt><CLEAR LINE> 

Incorrect/ 
Remain 
here 

3 &{rings|bar*|floor| 
horse|beam|vault}& 

Though the narrator mentions <LAST>, the 
sport is actually even broader. Listen again. 
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Since case (capitalization) is not a concern in this response, click Options, then uncheck 
the “Check Case” option.  This way, WinCALIS will accept “gymnastics” or 
“Gymnastics”, “rings” or “Rings”.  Finalize those responses and options by clicking Done 
in the answer dialog box. 
 

Cloze-ure 
We will now create a Cloze Exercise Task, allowing the student to ‘fill-in-the-blanks’ for 
missing words in context.  In this task type, you first enter all of the text, then make the 
marks to indicate what will be deleted from the text and replaced with underscores.  
Because the format of this question is different from what the student has seen so far, 
let’s include Directions to go along with this task. 
 

!POPUP (GROUP DIRECTIONS):10 
 
<MCICTRL:HIDE> 
 
You have been introduced to the Olympic motto and the Olympic  
creed. Now you will be presented with the Olympic oath, but with 
a few words left out. See if you can guess them from their context. 
 
In the same task, go to the Interactive (Question) Window: 
 

!INTERACTIVE (QUESTION):10 
 
 
In the name of all competitors I promise that we will take part 
in these Olympic Games, respecting and abiding by the rules which 
govern them, in the true spirit of sportsmanship for the glory of sport 
and the honor of our teams. 
 
To avoid typing this text, you may import the document file “oath.txt” from your working 
tutorial folder (review Task 3 for how to do this). 
 
Now click on Task|Cloze.  The text will then be shown in the dialog box.   
 
Double-click the word “promise”; it will appear highlighted.  Then click the Mark 
button.  You will be asked for confirmation of entering the Mark phase.  The word you 
chose will then appear in the text surrounded by double angle brackets. 
  
Similar to the way alternate answers were anticipated for the other question types, we 
shall provide feedback and other answers for the Cloze.  With <<promise>> highlighted, 
click More..., and then insert in the appropriate boxes: 
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Response 
Type: 

Current 
Response: 

Anticipated Response: Feedback: 

Correct / 
Continue 

1 promise (which appears 
automatically) 

That’s right; the athlete is making a 
promise. 

Incorrect/ 
Remain here 

2 pledge|vow This is a good choice, but not the 
exact word in the oath. 

 
 
 
Then highlight the word “rules”, Mark it, and click More: 
Response 
Type: 

Current 
Response: 

Anticipated Response: Feedback: 

Correct / 
Continue 

1 rules Yes, athletes promise to abide by the 
rules of the Games. 

Incorrect/ 
Remain 
here 

2 rule Notice that the verb 'govern' must be 
parallel with a plural form. 

 
Then highlight the word “sport” and Mark it. Here, we will add a contextual Clue (a 
button will show up automatically for the student).  Highlight the ‘sport’ portion of the 
word ‘sportsmanship’ which appears earlier in that same line.  Then click the Clue 
button.  
 
You can also click More… and add a second anticipated response: 
 
Response 
Type: 

Current 
Response: 

Anticipated Response: Feedback: 

Correct / 
Continue 

1 sport  

Incorrect/ 
Remain 
here 

2 sports This is the right word, but the oath 
follows British usage. Omit the 
plural 's'. 

 
Click Done to save the contents of the Cloze exercise dialog box. 
 

Save your script!  
 

 Try out your lesson! 
 
Congratulations! 
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